f . \ 1 1 Auto-upload settings enable this product to automatically upload data to T&D WebStorage Service.\
Thermo Recorder T&D WebStorage Service O pe ra t I o n s VI a c I 0 u d A Please read the T&D WebStorage Service License Agreement carefully before making settings.

T R-7 nW Se ries U se r's M a n u a I T&D WebStorage Service is a free cloud-based storage service provided by T&D Making Auto-upload Settings indicates your acceptance of this Agreement.

Corporation, which enables you to access the uploaded recorded data from a web ﬂ 6 After data is sent to "T&D WebStora T
. . . ge Service" either by auto-upload
Maklng Auto-UpIoad Settmgs or by pressing the <REC/STOP> button on the logger, the added

browser and check the current readings, remaining battery life of the device, and
device and its measurements will appear in the [Data View] window.

T& D Corporation alert status. You can also receive warning notifications by email. In order to use the

tandd.com 2022.11 16504980027 (10th Edition) © Copyright T&D Corporation. All rights reserved. T&D WebStorage Service, user registration (free) and device registration are required. By ma king settings for auto-upload, itis pOSSible to automatically
upload recorded data to the online “T&D WebStorage Service”.
Important Notes teotetered Devices lock Display Settings
D + Before registering as a user, please read [Service Details / License Agreement] for M
H information on service contents and specifications, including the data storage 1. Connect a LAN cable to the Ethernet port. )
T&D Thermo (android, i03) . period in the T&D WebStorage Service. &2l TR-7 series
Measure App for Accessing Cloud to View . . . . . . .
Record Data in Graph, Save and Make ' * The registration code of the device can be found on the supplied Registration If you wish to use a static IP address instead of DHCP, change the network settings R e oo e TED el
Setting Changes Code Label. If you lose the code label, install the software TR7 for Windows and on our software "TR7 for Windows" by connecting the device to a PC via USB. For ) [ nar _
Z Wired LAN connect your logger via USB to the computer. The registration code and device details about operations please see the "Help" menu in the software. ' s | e 7asr ek
,:J@ =, Automatic Data Upload .\Il-va:a?:ngturage information will be displayed at the lower-left area of the screen. 1o = R
h Service * When the storage period in T&D WebStorage Service is exceeded, old data will be 2. Click the <INTERVAL> button '
« twice to display the current T I @
. Download View ¢ H : : -—y e
ﬁ_?nw_s Recorded Data via Web Browser User and Device Registration Procedures upload interval. .' ) '
/5w J 1. Access T&D WebStorage Service from the web browser. _, ’_, If measurements are not displayed:
USB Connection to a PC D + Check the device screen to make sure @3 is ON. Recorded data will not be uploaded
— - www.webstoraae-service.com . . when recording is not in progress.
TR7 for Windows 9 3' Press the <INTERVAL> button until the display flashes. + Try sending data to "T&D WebStorage Service" again by pressing the <REC/STOP>
Software for Making Settings and Downloading Data 2. Click [Create Account] to go to the registration page, and follow the directions to i i i e L
colmp[lete e regi:tra]tiong gistration page, w irecti 4. W|th eqch pressing of the <INTI?RVA_L> button the upload mtervgl + See "Checking Connection Status" in step 2, and check if the device has a LAN connec-
T&D Graph time will change. When the desired interval appears, stop pressing tion.
Software for Viewing Graphs, Saving and Analysis 3. Login by entering the registered User ID and Password. the button
) . . . . . : If the display of measurements is not refreshed:
4. Click [Devices] in the left menu to open the Device Settings window. . . - .
In this document, TR-71nw, TR-72nw, TR-72nw-S and TR-75nw are collectively referred to as the o ) } ) If you wish NOT to use the auto-upload feature, select “OFF". We recommend making the recording interval shorter than the auto-upload interval. If
“TR-7nw Series” or simply as the “device” or “logger”. 5. Clicking the [+Device] button will take you to the Add a Device page. Within a few seconds, the display will return to measurement mode jche.recordmg |n.terva| is set to Iorjger than the upload mterval', the same measurement
6. Enter the serial number and registration code for the device, then click [Add]. S - . Bl Uil e MO (el ) CEelis el e e CELE IS U R ek
k ) to indicate the upload interval is set. ' s
If you cannot find the registration code:
Below are some examples of upload intervals and the corresponding estimated See [T&D WebStorage Service] - [important Notes] on the left side of this paper.
( \ battery life
R . In general, the shorter the upload interval, the shorter the battery life. R .
Recording Interval Setting , ' _ _ : Viewing Data from other than a Web Browser
4. Press <INTERVAL> again to select the interval time. Each press Upload Interval 1 min. 10 min. 1hr. 12 hrs.
Install the batteries and sensor(s) in the logger, and make sure changes the interval as follows: BatteryLife | About10days | About2months | Aboutdyear | About1.5years Recorded data sent to "T&D WebStorage Service" can be accessed,
the LCD is displaying measurements. The factory default setting Recording Intervals (Rec.) 1, 2, 5, 10, 15, 20, 30 sec/ 1, 2, 5, 10, 15, 20, 30, 60 MIN viewed and downloaded directly from "T&D Thermo" and "T&D Graph"
for the recording interval is 10 minutes for TR-75nw and 1 minute . : , , : : : . :
g . 5. When you stop pressing the button, the dlsplay will return to the + All estimates are based on operations carried out with a new battery and are in no as well as from a web browser
for TR'71 nw/TR-72nw. Follow the procedure below to Change this normal measurement mode, confi rming that it is set. way a guarantee .Of actual battery life. ‘ ‘ ‘ Here explains how to view data from "T&D Graph". For information about "T&D Thermo",
setting. * The auto-upload interval can also be changed during a recording session. see [Operations via Mobile APP] on the back of this manual.

6. Start recording by pressing and holding the <REC/STOP> button until
1. Download and install the software T&D Graph from T&D Website.

@ « Skip this setting if you d(?n’t need to.change the recording interval. . the @ mark appears in the display.
+ Upon the start of recording, all previously recorded data in the logger will be
deleted. Below are some examples of recording intervals and maximum recording times. Insta"ing the Device tandd.com/software/td-graph.html
* Note: When @3 is ON (recording in progress), the logger cannot be turned 1 sec. 30 sec. 5 min. 15 min. 60 min.

off , nor can the recording interval be changed. About 2 hours About 2 days About 27 days About 83 days About 333 days Install the device to the actual place it will be used. 2' From the [File] Menu, select [Web Storage Service].
1. When @@ is ON, press-and-hold the <REC/STOP> button until 3 Recording Intervals & Corresponding Maximum Length (in days) of Data Stored in T&D WebStorage Service Check Internet Connection Status ?T&;:Tm —
i R di 1 2 5 10 15 20 30 1 2 5 10 15 20 30 0| wew al-N -FJA 2 O 52| EES DS
turns OFF (recordlng StOpS). frft(:arrJ:Ig sec. | sec. | sec. | sec. | sec. | sec. | sec. | min. | min. | min. | min. | min. | min. | min. 1hr. 5 | open. ctri+0
2 Maximum Length 2 | 3| 6| 9 | 12|20 40 | 80 | 200|450 | 450 | 450 | 450 | 450 [RoC Rt ol [ ———
. Press the <INTERVAL> button. (in days) 1day days | days | days | days | days | days | days | days | days | days | days | days | days | days I ::s:‘sze:“;]“ )
3. While Rec. is displayed, press-and-hold the <INTERVAL> button by I B | h Welcome to

In order to stop a recording session, press and hold the <REC/STOP> button until the

until the interval time flashes. . ;
@@ mark disappears from the display.

C L
Internet Router / HUB 3. Enter the User ID and Password registered with T&D WebStorage Service,

k ) and click [Login].

Checking Connection Status Upon successful login, the recorded data of the devices registered

By pressing the <REC/STOP> button, recorded data will be sent to "T&D WebStorage with your account will be dlsplayed.

. . Service". If the transmission is successful, Web will still be ON even after communica- ; ; ; ;
Details about the LCD Display Messages on LCD Screen TR U

‘@ is blinking : Ethernet connection established and data is being transmitted.

Other than the measurement display, the following is displayed on o o_ _ _ _ Sensor Error: No sensor connected, improper connection, damaged, etc. Wehb s ON : Internet connection is successfully established.
the LCD monitor. Weh is blinking : Internet connection failed. Please check the network settings. @ Cha nging the Settings

Web | Internet Connection Status Full Data: Upon reaching capacity of 8,000 readings in "ONETIME" mode,
D com @R LT ON : Connected to the Internet this message appears and recording automatically stops. By using the “T&D WebStorage Service”, it is possible to change

Wel

b Upload.Rec. HOUR MIN SEC \ . ) . .
BLINKING : Unable to connect to the Internet. - : the followmg settings
i} ™ % . ) : A EEr a| Sleep Mode: If you take no action after a battery warning mark appears . .
',‘.' '_' ' [ | OFF : Auto-upload is set to “OFF". - and auto-upload stops, the logger will enter sleep mode and stop all Checki ng Recorded Data . —
@I o i i Device Information:

m@ Displayed Measurement Channel operations to protect data.
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All operations are stopped to protect data in sleep mode. " T ; ; ; .
CcCOoM LAN or USB Communication in Progress « If the logger remains in sleep mode over one week without a change of 1° Access T&.D WepStorage Service" from the web browser on your Device Name, Group Nam'e’ Recor(_jmg Interval, Recordlr?g Mode, Auto upload
—— batteries, all recorded data will be lost. PC or mobile device. Interval, Channel Name, Time Settings, Temperature Unit
l:!ga ecoraing >tatus
ON: Recording in progress bst : Warning Settings:
BLINKING: Waiting for programmed start - www.weps Orage-ser\"ce’com L — . . .
OFF : Recording stopped Thermocouple Sensor Type (TR 75nw only) Lower Limit, Upper Limit, Sensor Warning, Judgement Time, Battery Warning
ENDLESS | Recording Mode By pressing and holding the <DISPLAY> button, you can see which 2. Click [Create Account] to go to the registration page, and follow the
ENDLESS : Upon reaching the logging capacity of 8,000 readings, the oldest sensor type is currently set for each channel as below. directions to complete the registration. If you already have your
ata is overwritten and recording continues. .
ONETIME : Upon reaching the logging capacity of 8,000 readings, [FULL] = ez | [= p——r—y In the example shown left User ID, go to the next step. oy
appears on the LCD display and recording automatically stops. Web Web . ' ) . . Tisenies
* Use "TR7 for Windows" or "T&D Thermo" to change the recording mode. (Cannot @ [} Channel 1is set to Type K, 3. Login by entering the registered User ID and Password. e — e
be changed by buttons on TR-7nw.) ,., @ / Channel 2 is set to Type J. . . . . . - . i ) e
4. Inthe [Device Settings] window click [+Device]. a4 v o moovw
DATAL Amount of Recorded Data in Device Other sensors ... offic (2 2 13 mi on oo | pe—
TypeT TypeE TypeR TypeS . In the Add a Device page, enter necessary information and click .
@ | Low Battery Level 5 page, ry . . T I e |
Please change the batteries as soon as you see this mark. If not, the device enters ) P P [Add]
sleep mode ([SLP] appears on LCD) and stops all operations. If the batteries are g g - h | The registration code can be found on the supplied Registration Code Label.
further left unchanged, all previously recorded data will be lost. — — = The changes in settings will be applied when the device communicates
Upload. |Indicates Auto-upload Interval when using <INTERVAL> button The factory default setting is “K” for both (1) (2] . Depending on the thermocouple type you're @ \[:l)vllte:;?ﬁe I%{(EC%?E)SFE(:rSLngtc?r?rc\)lll'lcﬁh.eTge?/?cF;l);;Pei cs:?t?r?gess ;T:;ﬁ?::)tlilgéd
Rec. Indicates Recording Interval when using <INTERVAL> button going to use, make settings or changes using “T&D WebStorage Service” or the software )

“TR7 for Windows". k J




Operations via Moble APP

@ "T&D Thermo” App Settings

1. Install "T&D Thermo" to your smartphone or tablet.

“T&D Thermo" is available on the Apple Store for iOS devices and the Google Play Store for
Android devices.

Search for "T&D Thermo" on the Apple Store for iOS devices and
the Google Play Store for Android devices.

Open "T&D Thermo".

. Tap the menu icon in the upper left corner of the screen, and tap
[App Settings].

N

N

Tap [Account Management] for T&D WebStorage Service.

o n

. Enter the User ID and Password for your account, and tap [Apply].
If you added more than one account, select the account you want to access.

. Tap K4 to return to the top screen.

@ Graph Display and Device Settings

1. From the list on the top screen, tap the device registered with
T&D WebStorage Service to open the Device Info screen.
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[ 25.1¢c & 33.7 % cloud.
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2. Tap [WebStorage] at the bottom of the screen.
This will access the logger via T&D WebStorage Service and open
the Graph/Device Settings screen.
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Graph Operations \
Pinch in/out to change the scale.

Zooming in and out

Full screen display Hold the smartphone horizontally.

Checking time and temperature at

the specified point Tap and hold on the graph (in full-screen mode).

Device Settings

You can view or make changes to the settings such as Rec Settings, Name Settings,
Warning Settings and Auto-upload Interval.

Changed settings will be applied the next time the device connects to the

T&D WebStorage Service.

The & icon indicates that
there are pending settings.
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Graph/Device Settings screen Device Info screen File List

1. To save the recorded data to your device, tap Il in the upper right
corner of the Graph/Device Settings screen.

2. Tap [Files] at the bottom of the Device Info screen to open the file
list.

3. Select a file and tap the desired icon at the bottom of the screen.

The icons on the bottom allow you to take actions on the selected data file such as sending to
T&D WebStorage Service, sending via email, sharing in SNS and saving directly to your smartphone.

2 3

For details about T&D Thermo, refer to the online help.

tandd.com/support/webhelp/tdthermo/

T&D Data Server

“T&D Data Server” is a Windows software that receives and stores data
recorded by TR-7nw Series data loggers to the server’s database. It is

possible to monitor current readings and warnings via a web browser.
When you wish to have recorded data automatically uploaded to your

tandd.com/software/td-data-server.html

1. Install T&D Data Server on the computer to be used as a server,
and open the [T&D Data Server Manager] window.

T&D Data Server Manager
Data Server Settings
Server Address | Bl IO IM ~
Port Number lII s
Send Warning Mail...
Log Meritor
Next Badkup: 20211124 02:00'00 Backup...
< | D)\ot allow the computer to enter sleep mode.

Version Info Help | Store in Task Tray | | Quit |

2. Enter the Server Address and Port Number.

\_

server rather than T&D WebStorage Service, please use "T&D Data Server".

~\

* The IP address(es) for the server PC will automatically appear. If there
are multiple networks, select the IP address for the network waiting for a
connection.

* The default Port Number is 80.

* The settings cannot be changed while the server function is running. Please
click the [OFF] button to stop the server function.

3. Place a check next to "Do not allow the computer to enter sleep
mode."

4. Click the [ON] button.

« If Windows goes in "Standby" or "Sleep" mode, reception of recorded data and
monitoring can not be carried out.

* The IP address and port number set here will be used in the Windows software
"TR7 for Windows" as the data destination in the Auto-upload Settings. For
details about operations of "TR7 for Windows" , please refer to the software's
Help.

Monitoring
To open the monitoring window, open your web browser, and in the address bar
enter the server address set in Data Server Settings.

Graph View
In the monitoring window, click the desired device name to view the data in graph
form.

For details about the operations of T&D Data Server, refer to

cdn.tandd.co.jp/glb/htmli_help/tddataserver-help-eng/

Operations via USB

It is possible to make device settings and download recorded
data by using the software "TR7 for Windows". Data
downloaded can then be viewed in a graph for analysis by
using our software "T&D Graph".

Primary features of "TR7 for Windows" include :

+ Start/Stop Recording

+ Auto-upload Setting

+ Network Settings (static IP address, etc.)
* Name Settings (device/group/channel)
+ Downloading and Saving Recorded Data

* Warning Settings

Time Settings

Sensor Type Setting (TR-75nw only)

* Report Creation and Output

Settings and Log Output

* Reset to Factory Default Settings

1. Download and install the software "TR7 for Windows" and
“T&D Graph" from T&D Website.

tandd.com/software/tr7forwin.htmi
tandd.com/software/td-graph.html

2. Connect the logger via USB to your computer.

I
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=

USB Communication Cable
(US-15C)

« "TR7 for Windows" will open automatically. (If not, please open it manually
from the Windows Start Menu or Start Screen.)

* For details about operations please see the "Help" menu in the software.

3. After the setup is complete, place the device to the desired
measurement location.

@ Downloading Recorded Data

1. Connect the logger via USB to your computer.

2. Open “TR7 for Windows”", click the [Download Recorded Data] tab
and proceed with the download.

[Detailed Settings] allow you to :

+ View and change the “Graph Display” and “File Name" settings
* Select whether to create a report (PDF/CSV) with daily maximum and minimum
values and total time out of threshold, etc.

5§ TR7 for Windows - X

File View Communication Settings Help

B EE T S

Connected Devices ®# Download Data I &) Start Recording | b Warning Seﬂmgsl &5 Auto-upload Settings

"Dcvwnloading Statu

TR-72nw_info

Download Recorded Data Detailed Settings

Detailed Settings...

Cancel | & All Data

~Graph Display |

[V After downloading, autormatically display graph:

[~ File Name

" Assign a file name to be saved " Specify Tine Period

Ttem [ settind | Save with the default file name 100%

—
Model Name TR-721 (Set in the [File Names and Folders...]} ? —
Group Mame infol3 | p—

~ Dally Max/Min Report
tput Channel(s): I ch.i W ch.z
ate a PDF report
itle
éate a CSV report Help

For details about the operations of TR7 for Windows, refer to

cdn.tandd.co.jp/glb/htmI_help/tr7win-help-eng/

~

@ Viewing Recorded Data in Graph

Open “T&D Graph” and then access the data you wish to view.
Upon completion of the download, "T&D Graph" will open and
display the graph.
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For details about the operations of T&D Graph, refer to

cdn.tandd.co.jp/glb/htmI_help/tdgraph-help-eng/

Device Button Operations

Thermo Recorder TR-71nw

<POWER> Button

L — ® @ ©

DISPLAY INTERVAL  REC/STOP.

Power ON/OFF Press-and-hold*1 the <PWR> button.

Start*2 / Stop Recording Press-and-hold the <REC/STOP> button.

Press the <INTERVAL> button.

Check Recording Interval / | With each pressing of the button, the display will
Upload Interval switch between the recording interval (Rec.) and
the upload interval (Upload).

Press the <INTERVAL> button. While Rec. is
displayed, press-and-hold*3 the <INTERVAL>
button until the interval time flashes. Press
<INTERVAL> again to select the interval time.

Recording Interval Setting

Press the <INTERVAL> button twice. While Upload
is displayed, press-and-hold the <INTERVAL>
button until the interval time flashes. Press
<INTERVAL> again to select the interval time.

Upload Interval Setting

Transmit Data and Settings

to T&D WebStorage Service Press the <REC/STOP> button.

Cancel Communication Press the <PWR> button.

Channel on Display (Fixed | Press the <DISPLAY> button to switch the display:
or Alternating Display) Ch1 (fixed) = Ch2 (fixed) = Ch1&2 (alternate)

TR-75nw Sensor Type Press-and-hold the <DISPLAY> button.

*1."Press-and-hold” means to hold the button down for about two seconds.
During recording, the power cannot be turned off.

*2.Upon the start of recording, all previously recorded data in the unit will be
deleted.

*3.Recording Interval setting cannot be changed while a recording session is
in progress.

Before performing button operations, please read the attached document
[Please Read First] and install the batteries and sensor(s) in the logger, and
make sure the LCD is displaying measurements.




